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Welcome Macintosh users -- to TRUMP CASTLE II, the Ultimate 
Casino Gambling Simulation inspired by the fabulous Trump Castle 
Casino Resort By the Bay in Atlantic City. Now yow can enjoy all the 
glamour, games and thrills of trying to capture a king's ransom--just as 
if you were actually inside Trump Castle! Multi-player capabilities, pull­ 
down menus and actual digitized photos and sound straight from· 
Atlantic City will make even a seasoned casino veteran feel right at 
home! 

Digitized animation captures the 
sights and sounds of gaming 
excitement. 

Hone your skill and try your luck with these six popular gambling games: 

ny 
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ENTERTAINMENT SOFTWARE 

BACCARAT Play the New Jersey version, derived from Chemin de Fer-­ 
one of Europe's oldest and most popular card games. 

BLACKJACK It's the game of "21 ", for up to four players--or practice 
strategies playing multiple hands 

CRAPS There's excitement in every roll of the dice with this multi­ 
faceted, fast-paced game 

ROULE'ITE Discover the many different types of bets and payoffs that 
roulette offers 

VIDEO POKER Animated, 5-card draw poker--just like the poker machines, 
popular everywhere 

SLOTS No casino is complete without at least one slot machine' 

*These rules and regulations may change from time to time. Always c 
actual gambling. 

Graphics are great on both color and 
black and white monitors. 

REQUIREMENTS: Macintosh computer with 1 
megabyte of available memory. Supports both 
color and black and white monitors 

Game play follows the rules and regulations of the New Jersey 
Casino Control Commission (except Video Poker).* It's the 
perfect way to prepare for your next visit to Atlantic City! 

Experience the super charged atmosphere of Trump Castle Casino 
Multi-player capabilities mean casino Resort, as you move about the spectacular casino. Digitized photos, 
funforuptofourplayers. animation, plus realistic graphics and sound bring the king-size 

excitement of Trump Castle right to your computer screen. Play your 
cards right and live the luxurious life of a "high roller", or watch a 
fortune disappear as you let it ride one time too many! Whatever your 
game, it's a safe bet you'll love the challenge and thrills 
of TRUMP CASTLE II ... Good Luck! 

Pull-down menus make it easy for 
everyone to "Mac-gamble". 
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Introduction 

Welcome to TR UMP CASTLE II, the all new Ultimate 
Casino Gambling Simulation inspired by the fabulous Trump 
Castle Casino Resort by the Bay in Atlantic City. Enjoy all 
the glamour, games and thrills of trying to capture a king's 
ransom - just as if you were actually inside Trump Castle. 

Experience the super-charged atmosphere as you move about 
the spectacular casino. Catch conversations around the gam­ 
ing tables. Digitized photos, animation, plus realistic graphics 
and sound bring the king-size excitement of Trump Castle 
right to your computer screen. 

TRUMP CASTLE II offers six popular gambling games - 
Baccarat, Blackjack, Craps, Roulette, Video Poker, and Slots 
- each with multi-player capabilities. Enjoy simultaneous 
casino action for up to four players, or practice strategies 
playing multiple hands. Game play follows the rules and 
regulations o( the New Jersey Casino Commission (except 
Video Poker) . 

From the exciting animation and sound to the realistic game 
play, multi-player capabilities and more - TR UMP CASTLE 
II sets a new standard for casino computer programs. So get 
ready for unlimited excitement and fun. Whatever your game, 
it's a safe bet you'll love the challenge and thrills of TRUMP 
CASTLE II. Good Luckl 

·These rules and regulations may change from time to time. Always confirm 
all rules in effect prior to actual gambling. 

Getting started 

Requirements 

In �rder to run Trump Castle II you will need the following 
equipment: 

• A Macintosh computer 
• 1 MB available RAM for the Color Version, 512K 

available RAM for the Black & White Version. 
• A hard drive with at least 2 megabytes available. 

NOTE: Please be sure you have the computer properly 
hooked up and are familiar with its operation. If there are 
questions about the computer, please refer to your owner's 
manual. 

Installation 

Before you can run Trump Castle ll, you must install the 
software. To install Trump Castle II on your hard drive, insert 
Trump Castle II Disk into your disk drive (insert the color 
version disk if you have a color system, or insert the black & 
white disk otherwise). 

To install Trump Castle II into its own folder, create a New 
Folder using the File menu and name it TRUMP CASILE 
II. 

Double-click on the Trump Castle II disk icon. Now, double­ 
click on the "Click on Me" icon to extract the program onto 
your hard drive. You will then be asked to select a destination 
folder for the program. Select the TRUMP CASILE II folder 
by double-clicking on its name in the file selector. 

On� you h�ve sel�ted the folder, click on Extract to begin 
the installation. It will take a few minutes to extract all of the 
files onto your hard drive. 
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Running the Program 

I To run the program, open the TR.UM� CAS1LE II folder and 
double-click on the Trump Castle II icon. 

Starting the Program 

Once loaded, the program will display an opening sequence 
(Color version only). At any point during the opening, press 
the mouse button to start the game. 

Player's names 

Before you start playing the games, you are asked to enter the 
names of one to four players. Select the number of players. 
Enter the name for Player #1. For each player that is going to 
play click in the player's name box and enter his/hername (or 
press the TAB key to move between the name boxes). After 
you have entered all of the players' names, press the RE­ 
TURN key. 

Bankroll 

Each time you start the game, you will have $1,000. You� 
use this money anywhere in the casino. Use all of your gammg 
ability to build upon this bankroll. 

Playing the Game 

Color Version 

Trump Castle II uses a point and click interface. Each screen 
in the game has one or more areas that you can click on to 
select an option or perform some type of action. Also, many 
of the people in the program have things to say. When a screen 
with a digitized picture is displayed, pressing the mouse 
button will show you a box around each and every available 
click area on the screen. 

To select an area, point at the area and press the button. 

The first thing you will see after the opening sequence is the 
lobby. From the lobby you can access any of the following 
options: 

Exit the casino 
Visit the cashier 
Play roulette 
Play craps 
Play blackjack 
Play poker 
Play baccarat 
Play slot machines 

Exit the casino 

Choose this option to leave the casino or click on the escalator 
to go to the Bus Stop. You will be downstairs preparing to get 
on the Trump Castle bus. Choose the bus to leave the game. 

Visit the cashier 

If you run out of money, you can go to the change booth and 
receive $ I ,000. 
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Black & White Version 

After the program loads, the main Trump Castle II �creen w!ll 
be displayed. On this screen are 6 icons representmg the six 
games. To select a game, point at its corresponding icon and 
click. 

Menus 
There are three menus that you will use from the Trump Castle 
II main screen: File, Play and Settings. Their functions are 
described below 

File 

Load Old Game 
This option allows you to load a game that was previously 
saved. Select the game from the file selector and choose 
OPEN. 

Save Current game 
From the file selector, choose a location for the save file 
(Trump Castle II folder) and enter a valid filename up to. 8 
characters in length and press RETURN. The program will 
save the current game, including players' names and bankroll 
amounts, to that file. 

Quit Trump Castle 
This option exits the game and returns you to the desktop. 

Play 
Tue Play menu provides an optional way to play any of the 
six games. Simply select the desired game from the menu. 

Settings 

Sound 
A check mark will appear next to the Sound option if sound 
is turned on. To tum sound off, select this option. To turn 
sound back on, select this option again. 

Display Resulis 
If you want the prowam to display the results of each turn 
(e.g. spin of the slotraachine), select this option. A check mark 
will appear next to this option when it is selected. 

Get More Money 
If you are out of money, you can select this option to get 
another $1000. 

Options Menu 
When you are playing any of the six games, you will have an 
options menu on the menu bar. The choices available on the 
options menu are described in the individual sections for each 
game in this manual. 

THE GAMES 

By selecting a game you will go to thatareaofthecasino. You 
can see what the other players have to say and then play the 
game. 

Black & White users: When you select a game, you will 
go directly to that game. You will not have the opportunity 
to have the characters in the games talk. 
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Roulette 

After selecting roulette from the lobby, you will find yourself 
standing around the roulette table with several people (color 
version only). Most of the people here have something to say. 
When you are ready to play, click in the middle of the table. 
Trump Castle II offers two types of roulette, 0 and Double 0. 
When asked, choose the one that you want to play. You will 
then be asked to select the table minimum ($1, $5, $25, $100). 

Placing bets 

The names of all the players along with the amount of their 
bankroll are displayed on the lower righthand side of the 
screen. 

Each player can take turns placing bets between each spin. To 
switch the current player, click on the desired Player button 
on the lower lefthand portion of the screen. 

To place a bet, click on the desired chip amount and bold the 
mouse button. Now place the pointer over the table al the 
point at which you would like to place your bet and release 
the button. The chip will stay at the selected spot 

When all bets are placed, click on the Spin button. 

Clearing bets 

To clear all the bets off the table, click on the Clear button. 

Options Menu 
Clear Bets 

To clear all bets off of the table. Performs same job as Clear 
button. 

Spin Wheel 

Performs same function as Spin button. 

Payoffs 

Shows a table of bow much each type of bet pays. Click the 
mouse button to make the payoff table disappear. 

' I 

Rules 

Displays the basic rules for playing roulette. Click the mouse 
button when you are done reading the rules. 

Quit Roulette 

Performs the same function as the Quit button. 

Craps 

After selecting craps, you will see the craps table with several 
other guests standing around (color version only). You can see 
what they have to say and then click in the middle of the table 
to play. You will be asked to select a table minimum ($1, $5, 
$25, $100). 

Placing bets 
The names of all the players along with the amount of their 
bankroll are displayed on the lower righthand side of the 
screen. 

Each player can take turns placing bets between each roll. To 
switch the current player, click on the desired Player button 
on the lower lefthand portion of the screen. 

To place a bet, click on the desired chip amount and hold the 
mouse button. Now place the pointer over the table at the 
point at which you would like to place your bet and release 
the button. The chip will stay at the selected spot 

When all bets are placed, click on the RoU button. 

Clearing bets 

To clear all the bets off the table, click on the Clear button. 

To clear an individual bet, place the pointer over the bet and 
bold down the command key and click the mouse button. 

Options Menu 
Remove a bet 

Tells you how to remove an individual bet from the table. 
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Roll Dice 

Performs same function as Roll button. 

Payoffs 

Shows a table of bow much each type of bet pays. Click the 
mouse button to make the payoff table disappear. 

Rules 

Displays the basic rules for playing craps. Click the mouse 
button when you are done reading the rules. 

Quit Craps 

Performs the same function as the Quit button. 

Blackjack 

After selecting Blackjack, you will be seated at a blackjack 
table in the casino (color version only). There will be many 
other people around the table. You can see what they have to 
say and then click in the middle of the table to play. You will 
then be asked to select a table minimum ($1, $5, $25, $100). 

At Trump Castle, Blackjack is played with six decks of cards. 

The names of all the players along with the amount of their 
bankroll ai:e displayed on the lower righthand side of Ille 
screen. 

The four playing positions are represented by white boxes on 
the screen. Any player can play in any position, or in more 
than one position. 

Placing bets 
Select a player by clicking on one of the four player buttons 
on the lower lefthand side of the screen. 

To place a bet for the selected player, click on Ille desired chip 
amount and hold the mouse button. Now place the pointer 
over the table at the bet circle below the white box for the 
desired position. Release the button and the chip will stay at 
the selected spot. 

When all bets are placed, click on the Deal button. 

Clearing bets 

To clear all the bets off the table, select the Clear Bets option 
from the Options menu. 

Game play 

The dealer will deal cards to each position that has made a 
wager. After all of the bands have been dealt. positon one will 
be highlighted. The player who has wagered in this position 
will be given two options at the bottom of the screen (Hit and 
Stand). The player will make his/her choices by clicking on 
the appropriate buttons. 

When that player stands or busts, the box will move to the 
next position and that player can make his/her choices. 

If the dealer's face card is an Ace, each player will be offered 
insurance. Follow the instructions on screen for placing in­ 
surance bets. 

After all of the players have made their choices, the dealer 
will either stand or take a hit. After the dealer stands or busts, 
all winning bets will be paid. 

Options Menu 
Clear Bets 

Remove all bets from the table. 

Hit 

Gives current player another card. 

Stand 

Current players stands on current cards. 

Double Down 

Current player can choose to double his/her current bet and 
receive only one additional card. You are prompted to enter 
the amount of additional bet to make. 
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Split Pair 

If the current player has been dealt a pair, he/she can choose 
to split. The amount of the bet is doubled and cards are dealt 
to each card from the pair. 

Deal 

Performs the same function as the Deal button. 

Payoffs 

Shows a table of how much each type of bet pays. Click the 
mouse button to make the payoff table disappear. 

Rules 

Displays the basic rules for playing blackjack. Click the 
mouse button when you are done reading the rules. 

Quit Blackjack 

Returns to the main game screen. 

Video Poker 

When you select video poker, you will see three video poker 
machines (color version only). Click on the center machine 
to play. You will be asked to choose to play the $1, $5, $25 or 
$100 machine. 

The name of the current player and their bankroll amount is 
shown on the top of the screen. Click on the Change Player 
button to select a different player. 

Video poker allows you to play 1 to 5 coins. Click on the 
desired number of coins. After the coins arc put into the 
machine, click on the Deal box to deal the cards. Below each 
card is a Hold button. Click on this button to toggle the card. 
After you have made your choices, click on U1e Deal button 
to re-deal. 

Options Menu 
Deal 

Performs the same function as the Deal button. 

Payoffs 

Shows a table of how much each type of bet pays. Click the 
mouse button to make the payoff table disappear. 

Rules 

Displays the basic rules for playing video poker. Click the 
mouse button when you are done reading the rules. 

Quit Video Poker 

Returns to the main game screen. 

Baccarat 

After selecting Baccarat, you will find yourself seated at a 
Baccarat table (color version only). You can see what your 
tablemates have to say and then click on the middle of the 
table to play. You will then be asked to select a table limit ($1, 
$5, $25, $100). 

The names of all the players along with the amount of their 
bankroll are displayed on the lower righthand side of the 
screen. 

The four playing positions are represented by numbered 
boxes on the screen. 

Placing bets 
To place a bet. click on the desired chip amount and hold the 
mouse button. Now place the pointer over the table at the bet 
location (Tie, Banker, Player) above ihe box for the desired 
position. Release the button and the chip will stay at the 
selected spot. 

When all bets are placed, click on the Deal button. 

Clearing bets 

To clear all the bets off the table, click on the Clear button. 
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Options Menu 
Clear Bets 

Performs the same function as the Clear button. 

Deal 

Performs same function as Deal button. 

Payoffs 

Shows a table of bow much each type of bet pays. Click the 
mouse button to make the payoff table disappear. 

Rules 

Displays the basic rules for playing Baccarat. Click the mouse 
button when you are done reading the rules. 

Quit Baccarat 

Returns to the main game screen. 

Slot machine 

After choosing to play the slot machine, you will see several 
guests standing in front of a row of machines (color version 
only). Click on the rightmost machine to play. 

You will then be asked to select what type of slot machine to 
play ($1, $5, $25, $100). 

You will be standing in front of a slot machine. The name of 
the current player along with their bankroll amount is shown 
at the top of the machine. To change the current player, choose 
Change Player from the Options menu. 

The slot machine will accept from I lo 3 coins. To put the 
coins in, click on the desired button. After the desired coin 
button is selected, click on the handle to spin the machine. 

Options Menu 
Spin 

Performs the same function as the handle on the slot machine. 

Change Player 

Selects a different player to be the current player. 

Show Payoffs 

If you want the program to display coins representing the 
payoff each time you win, select this option. A check mark 
indicates the option is selected. 

Rules 

Displays the basic rules for playing slots. Click the mouse 
button when you are done reading the rules. 

Quit Slots 

Returns to the main game screen. 

Miscellaneous 

Opening other applications while using Trump Castle II may 
overwrite chips and/or cards left on the table. 

There may be some versions of the Macintosh Classic that 
will fail if Trump Castle II is the first application run after 
turning the computer on. 
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Additional Information 

Backups 
Backup copies of Trump Castle II are available directly from 
IntraCorp. The $12 charge for the set can be paid by check, 
money order, American Express, Visa, MasterCard, or COD. 
To order, write to IntraCorp, Inc., 7200 Corporate Center 
Drive, Suite 500, Miami, FL 33126 or call 1-800-INTRACO 
(1-800-468-7226) between 10 a.m. and 6 p.m. Eastern time 
(Monday through Friday). 

Technical Support - Please read carefully 
Registered owners of this software product are entitled to 
technical support from our Customer Service Depart­ 
ment. H you have any problems or questions, please call 
Customer Service at (305) 591-5900 between 10 a.m. and 
5 p.m. Eastern time (Monday through Friday). Please note 
that the warranty card that came with this product must 
be mailed to lntraCorp before any assistance can be given. 
Please allow sufficient time for the card to arrive before 
calling Customer Service. 

The IntraCorp Customer Support bulletin board is available 
to all users. Callers can leave questions to the Technical 
Support department or to other users, and get information on 
software upgrades and new releases. The board is available 
to users 24 hours a day. The board's number is (305) 471- 
8962. It is accessible at 300, 1200 or 2400 baud; no parity; 8 
data bits; l stop bit, 

Credits 
Trump Castle II is sold under license to the user. Please see the licensing 
agreement included with the package for details of the license. 

Macintosh is a trademark of Apple Computers Inc. 

Program, manual and packaging design Copyright 1991, 1992 IntraCorp, Inc. 
Trump Castle II User's Manual by David Turner. 

Page 15 TRUMP CASTLE II Macintosh User's Manual 


